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Introduction
Welcome to SUDS, the brewers database and log program.    This program provides a single 
place to put all of your recipes, log entries and miscellaneous brewing comments. Provided 
is a full featured multi-windowing editor, a formatted log entry system, Hop IBU spreadsheet,
calendar, calculator, label printer and a host of other features.

SUDS was written in Borland Pascal with Objects 7.0 along with the Topaz DBase engine for 
Windows.



Toolbar Commands
SUDS commands can be entered either by selecting the desired command from the menu or
by pressing one of the "Toolbar" buttons.    The following commands are available via these 
"Toolbars":

Display help about the current SUDS function.
Get a recipe from the SUDS database for editing
Formulate a recipe using the SUDSW recipe formulator
Open Log file for current recipe.
Save a recipe back into the SUDS database
Allows you to selectively filter which recipes to display in Recipe Selection box.
Searches for characters or words in recipe text.
Repeats the last search without opening the Find dialog box. 
Deletes text from recipe or log entry and places it onto the Clipboard, replacing the 

previous Clipboard contents. 
Copies text from a recipe or log window onto the Clipboard, leaving the original intact

and replacing the previous Clipboard contents. 
Pastes a copy of the Clipboard contents at the insertion point or replaces selected 

text in a recipe or log entry.
Displays the judging dialog box which allows entry of beer judging and comments for 

a recipe batch.
Displays a Hop IBU spreadsheet for determining International Bittering Units for your 

recipe log entry.
Undoes your last editing or formatting action, including cut and paste actions.
Prints a SUDS recipe or log entry.



File Menu
The SUDS file menu offers the following options:

New recipe 
Formulate recipe 
Get Recipe 
Get Template 
Open File 
Save 
Save to File 
Delete 
Open Log 
Print 
Printer Setup 
Exit 



New recipe
Selecting the New Recipe option from the file menu opens a new untitled window for you to 
enter new recipe text into.    Often you may prefer to use one of SUDS provided templates or 
an external file to create a new recipe.



Get Recipe
Selecting the Get Recipe option from the file menu will display a selection list of all existing 
recipes in the SUDS database.    Selecting a recipe will display the text in an editing window 
where it may be changed.

While the recipe list box is focused, pressing the Home key will go to first recipe. Pressing 
the End key will go to last recipe. Pressing any letter will go to the first recipe beginning with
the letter pressed.

The Unfilter button will be active only if a filter has been specified for the SUDS database.    
Pressing this button will clear the currently active recipe filter. If no filter has been specified, 
this button is grayed out.



Formulate Recipe
The Formulate recipe button or menu option invokes the SUDS recipe formulator. This 
window allows you to easily put together a customized recipe and will calculate starting 
gravity, bitterness, total grain bill and color based on the ingredients selected.    Whether 
using extracts or all-grain, this window allows you to enter the ingredients and compare the 
resulting recipe to all AHA approved styles as of March, 1994.

The Recipe Formulator Window is broken into the following sections:
AHA Style Picklist 
Recipe Name Section 
Malt and Sugars Section 
Hops Section 

Pressing the Notes button will open up a window to type free form information about the 
recipe you are creating such as yeast used, mashing techniques etc.

See Also:
Using the Recipe Formulator.



AHA Style Picklist
The AHA Style Picklist is located at the top of the Recipe Formulator window.    Pressing the 
down arrow button will display a list of all AHA approved beer styles and their gravity, 
alcohol, bitterness and color ranges.    You should pick the style that you are trying to 
formulate.    You can also add styles of your own to the SUDS database by selecting the AHA 
Style Maintenance option from the Options menu.



Recipe Name Section
The Recipe Name section of the Recipe formulator is where you key in various recipe 
information including the name of the recipe, how much it makes and the extraction 
efficiency.    This area also shows the calculated recipe statistics as you enter your 
ingredients.    These informational fields are the total weight of malt, calculated color,Original
Gravity, and Hop IBUs.



The extraction efficiency is only relevant when you are mashing grains.    It is applied to the 
theoretical yield for the malt.    For example, if you were mashing 10 lbs of Pale Ale malt, 
your theoretical yield (gravity) would be 1.072 assuming 100% efficiency.    A more realistic 
efficiency for home mashing might be 75%, so your calculated starting gravity would be 
1.054.    In my own experience (single-step infusion mashing), my extraction efficiency has 
been 65% or so.



Color is calculated in degrees lovibond or srm (Standard Reference Method).    The higher the
number, the darker the beer.    Lovibond values are based on a comparison of the wort's 
color against standard color strips.    SRM values are calculated more scientifically.



The original gravity is a calculation based on the type of malts and sugars used.    It is a 
prediction of what your initial hydrometer reading will be based on the recipe volume and 
types of malts/sugars used.



Malt and Sugars Section
The Malt and sugars section of the recipe formulator is where you select the types of malt 
and/or sugars you are using in your recipe.    Pressing the Pick Malts button will display a 
list box where you can select any number of malts to be used in your recipe.    This is a multi-
selection list box, so you can select all of your malts at once.    If you need to add a new malt
type, select the Malt Maintenance option from the Options menu.]

Pressing the Unpick button when an entry is selected will remove the malt or sugar from the
recipe.

Once the OK button is pressed, the selected malts show up in the malt box.    You then need 
to specify how much of each malt or sugar is to be used.

To do this, you can select a malt and press the edit button to key in the exact amount and 
units of measure (lbs, oz, kg, g) or you can press the + or - buttons repeatedly to increment 
or decrement the total malt amount.

As you select various malts/sugars and quantities, the calculated gravity of the batch will be 
updated dynamically.



Hop Section
The Hops section of the recipe formulator is where you select the types, quantities and boil 
times for any hops you are using in your recipe.    Pressing the Pick Hops button will display 
a list box where you can select any number of hops to be used in your recipe.    This is a 
multi-selection list box, so you can select all of your hops at once.    If you need to add a new
hop type, select the Hop Maintenance option from the Options menu.

If you are adding the same hop twice in the same recipe at different times, you will have to 
press the Pick Hops button more than once.

Pressing the Unpick button when an entry is selected will remove the hop entry from the 
recipe.

Once the OK button is pressed, the selected hops show up in the hop box.    You then need to
specify how much of each hop is to be used and the time it is boiled.

To do this, you can select a hop and press the edit button to key in the exact figures and 
units of measure (oz, g) or you can press the + or - buttons repeatedly to increment or 
decrement the total hop amount.

As you select various hops and boil times, the calculated IBU for the batch will be updated 
dynamically.



Filtering SUDS Recipes
The Filter function from the button bar or Search menu allows you to limit the recipes shown 
in the Get Recipe window based on search parameters that you specify.

When your recipe list gets into the hundreds (which it will if you use my utility to add Cat's 
Meow files - SUDSCM!), this can greatly reduce time spent searching recipes.

The Filter dialog box allows you to limit recipes shown by their Category, Method, minimum 
and maximum gravities or alcohol content and by text contained within the recipe.

You can also put a 'check mark' in the Logged Recipes Only box to limit the list to only 
recipes that you have actually used.

For all options except recipe text, only recipes meeting ALL of the criteria are selected.    For 
recipe text searches, you may enter one search phrase per line.    If ANY one of the search 
phrases is found within the recipe, it is selected (providing that it meets all other non-text 
search criteria).    Its a good idea to limit the search as much as possible with non-text fields 
since text searches are more time consuming.

Once the search has been performed, the recipe selection list shows only recipes meeting 
the filter options specified.    The filter remains in effect until you end the program or press 
the Unfilter button from the Get Recipe dialog box.



Get Template
Selecting the Get Template option from the file menu will display a list of template recipes 
for most popular beer and ale styles.    Selecting one of these will load the template into an 
untitled edit window to provide a quick method of formulating new recipes.



Open File
Selecting the Open File option from the file menu will bring up an Open dialog box which 
allows you to edit a file external to SUDS.    This allows you to import recipes from external 
sources such as text files, messages, etc. into your SUDS database.

If the size of the external file exceeds 20K, SUDS will automatically execute Windows Write 
or whichever external editor you configured to display the file.    This is because the internal 
SUDS editor cannot directly handle files over 20K in size.

From the external editor, you can still copy text into the clipboard and paste it into your 
SUDS windows.



Open dialog boxes
An Open dialog box is where you open a file by typing the file name in the input box or using
the list boxes to find and open the file.

File Name input box

The File Name input box is where you enter the name of the file to open.

Files list box

The Files list box lists the names of files in the current directory that match the file-name 
mask in the File Name input box, plus the parent directory and all subdirectories.

Directories list box

You view the contents of different directories by selecting a directory name in the Directories
list box.

You can also use shortcut keys (those underlined on your screen) to get to the area of the 
dialog box you want. 

For example, pressing Alt+D outlines the first directory in the Directories list box.



External Editor
The internal editor in SUDS is more than adequate to edit recipes and small text files.    
However, the maximum file size that can be edited by a SUDS window is 32K.    To 
accomodate files larger than this, SUDS will execute an external editor program such as 
Windows Write.    You can optionally configure your own external editor if you choose not to 
use Windows Write.

This dialog box allows you to select an external editor to use for large files.    

File Name input box

The File Name input box is where you enter the name of the editor to specify.

Files list box

The Files list box lists the names of files in the current directory that match the file-name 
mask in the File Name input box, plus the parent directory and all subdirectories.

Directories list box

You view the contents of different directories by selecting a directory name in the Directories
list box.

You can also use shortcut keys (those underlined on your screen) to get to the area of the 
dialog box you want. 

For example, pressing Alt+D outlines the first directory in the Directories list box.



Save
Selecting the Save option from the file menu will save the current window in the SUDS 
database.    If the current window is a recipe, the Save Recipe dialog box will be displayed for
you to enter the recipe details.    If the current window is a log entry, it will be saved with its 
current values.



Save to File
Selecting the Save to File option from the file menu will bring up a file save dialog box which 
allows you to save the contents of the recipe window as an external text file.    This file can 
then be edited externally, exchanged or whatever.    This option works only for Recipe 
windows.



Delete
Selecting the Delete option from the file menu will bring up a confirmation screen to delete 
the current recipe or log entry (whichever happens to be on top).    If no recipe or log entry is
displayed, a recipe selection list will be shown.    Answering yes on the confirmation screen 
will delete the recipe or log entry.



Open Log
Selecting the Open Log option from the file menu will bring up a list of log entries for the 
current recipe if any exist.    If no entries exist, the add log entry screen will be displayed.    If 
no recipes are currently open, a list of all existing log entries is displayed.



Print
Selecting the Print option from the file menu will bring up a confirmation screen to print the 
current recipe or log entry.    For recipes, the confirmation screen allows you to optionally 
print
      Recipe text
      Statistics
      Log entries



Printer Setup
The Printer setup option will display your printer's setup dialog box.    This allows any 
installed Windows printer to be selected and setup. This is used mainly if you have more 
than one printer installed, use a fax modem, etc.



Exit
Selecting the Exit option from the file menu will prompt you to save any unsaved recipes or 
log entries and will then exit the SUDSW program.



Edit Menu
The SUDS edit menu offers the following options:

Undo

Undoes your last editing or formatting action, including cut and paste actions. If an action 
cannot be undone, Undo appears dimmed on the Edit menu.

Cut

Deletes text from recipe or log entry and places it onto the Clipboard, replacing the previous 
Clipboard contents. 

Copy

Copies text from a recipe or log window onto the Clipboard, leaving the original intact and 
replacing the previous Clipboard contents. 

Paste

Pastes a copy of the Clipboard contents at the insertion point or replaces selected text in a 
recipe or log entry.

Delete

Deletes selected text from recipe or log entry, but does not place the text onto the 
Clipboard. 
Use Delete when you want to delete text from the current recipe or log window but you have
text on the Clipboard that you want to keep. 

Clear All

Deletes all text from recipe or log entry but does not place text onto the Clipboard.
Be careful with this option as Undo won't work with it!



Search Menu
The SUDS search menu offers the following options:

Filter SUDS Recipes

Displays the filter dialog box which allows you to list only recipes meeting the criteria that 
you specify.

Find

Searches for characters or words in recipe text.
The search can optionally be case sensitive.

Find Next

Repeats the last search without opening the Find dialog box. 

Replace

Searches for characters or words in recipe text and replaces found occurrances with the 
specified replacement text.

You may specify whether case sensitive search should be done, whether all occurrences 
should be changed and whether you want to be prompted before each replacement.



Options Menu
The SUDS options menu offers many options for controlling how SUDS operates. The options 
are:

Sort Order
Toolbar
Pack database
Export
Import SXF file
Hop Maintenance
Malt Maintenance
AHA Style Maintenance
Configure External Editor 



Sort Order Option
The Sort order option will allow you to specify whether recipe selection lists will be presented
alphabetically by recipe name or alphabetically by recipe category.



Toolbar Option
The Toolbar option will allow you to specify whether the SUDS toolbar should appear 
horizontally across top of screen, vertically on left of screen or vertically on right of screen.



Pack Database Option
The Pack database option will optimize the internal files used by SUDS.    One shortcoming of
the DBASE III/IV file structures (which SUDS uses internally) is that text files quickly grow 
larger leaving empty "spaces" in the files.    This option compresses the files used and 
consequently save space and improves performance.



Export Option
The Export option, brings up a sub-menu allowing you to select the file format to export your
recipes into.    The "SXF" format is preferable if you intend to share your recipes with other 
users of SUDS.    Otherwise, the text file format produces a printable text file of all selected 
recipes.

Both options will export only recipes that meet the filter conditions that you specify.

The advantage of using the SXF format over merely exporting to a file is that SXF files also 
carry the recipe statistics (gravities, volume, etc.).    Text files do not.



Import SXF file Option
The Import SXF option will import recipes from an SXF file into your SUDS database.    This 
allows you to load in recipes from other SUDS users.    The recipes provided free with SUDS 
(RECIPES.SXF) are in SXF format and should be imported in this fashion.    This option will 
not overlay a recipe if the name already exists in your database.



Hop Maintenance Option
The Hop Maintenance option will allow you to add, delete or update hop information in the 
SUDS database.    This allows you to maintain hop types and AA (Alpha-Acid) values.    Hop 
values are also automatically updated whenever you use the IBU calculator.



Malt Maintenance Option
The Malt Maintenance option will allow you to add, delete or update malt information in the 
SUDS database.    This allows you to enter the name of the malt, original gravity or expected 
yield, the color value (lovibond or srm) for the malt and whether or not the malt or sugar is 
mashed.

If you are entering a type of sugar (ie honey, molasses) or malt extract be sure to uncheck 
the mash box since these are already converted to sugar and you should get 100% of the 
OG figure.

Note - The Original Gravity field is based on a 100% extraction efficiency which no one 
actually achieves! If you are adding numbers based on your own mashing experience you 
must adjust the number accordingly. First you must calculate the equivalent gravity you 
would achieve by mashing one pound of grain in 1 US gallon of water. You then need to 
factor in your typical extraction efficiency. For example if you calculated for a given malt that
one pound in one US gallon would achieve 1.040 OG and you typically have a 75% 
extraction efficiency, you would adjust and key in 1.050 to the OG field.

The best way to update this information is to get figures from publications or directly from 
malt suppliers!



The expected yield (original gravity) is what you would achieve with 100% extraction 
efficiency when mashing one pound of the malt or sugar in 1 US gallon of water.



The color value is measured in degrees lovibond or srm (Standard Reference Method) and is 
the color expected for one pound of the material in 1 US gallon of water.    The higher the 
number, the darker the beer!



AHA Style Maintenance Option
The Style maintenance option allows you to add, delete or edit Beer style profiles within the 
SUDS database. These style profiles are used by the Recipe Formulator to compare against 
the results of your recipes. SUDS comes will all AHA approved beer styles pre-loaded into the
database (as of March, 1994).

For each style profile, minimum and maximum figures are kept for Original Gravity, Percent 
alcohol (by volume), International Bittering Units and Color (lovibond or srm).



Configure External Editor
The Configure External Editor option will display an open file dialog box allowing you to 
specify an external editor to use for large files opened from SUDS.    The default within SUDS 
is to use Windows Write.



Categories of recipes include Pale Ale, Stout, etc. or any category of beer that you choose to 
add to your SUDS database.



Tools Menu
The SUDS Tools menu offers the following options:

Calculator

The Calculator option initiates Microsoft's calculator utility from within the SUDS application. 
This allows you to make any calculations and optionally copy the results into the Clipboard 
from where they can be Pasted into your database.    See Windows documentation for details
on Calculator.

Calendar

The Calendar option takes you directly into Microsoft's calendar utility from within the SUDS 
application.    See Windows documentation for details on Calendar.

Hop IBU Calculator

The Hop IBU Calculator option is only valid from a log entry screen.    This option displays a 
Hop IBU spreadsheet for determining International Bittering Units for your recipe batch.    On 
the spreadsheet you specify hops used in your batch and the time in the boil.    SUDS 
automatically determines the Hop IBU value from this information and fills in the log window 
Hop IBU field.

Judge Log Entry

The Judge Log Entry option is only valid from a log entry screen.    This option displays the 
Judge Entry dialog box to enter taste ratings and judge's comments for a recipe batch.

Print Beer Labels

The Print Beer Labels option is only valid from a log entry screen.    This option displays a 
sample label dialog box which allows you to customize the information to be printed on your 
labels.    In this dialog box, you specify the label text and the number of labels to print.    
Note - When editing the label text, do not use the Enter key.    This will close the dialog box 
and begin printing labels.    Use the mouse or arrow keys to maneuver around when editing 
label text.



Hop IBUs (International Bittering Units) are a worldwide standard of bitterness measurement 
based on hop isomerization (how readily the alpha acids are converted to iso-alpha acids) 
and the percentage of alpha acids contained in the hops used.



Window Menu
The SUDS Window menu offers the following options:

Close All

Selecting the Close all option will close all open recipes and/or log entries prompting you to 
save if necessary.

Cascade

Selecting the Cascade option will organize all recipes and log entries within the SUDS 
"desktop" in a cascading fashion (Try it!).

Tile

Selecting the Tile option will organize all recipes and log entries so that all are visiblt on the 
SUDS "desktop".

Arrange Icons

Selecting the Arrange icons will neatly organize any recipes and log entries that are 
minimized at the bottom of the SUDS "desktop".

Window list

The Window menu option also lists all currently open recipes and log entries.    Selecting one 
of these will put the recipe or log entry on top of the SUDS "desktop".



Entering Recipes
Entering recipes into your SUDS database can be accomplished in many ways.    You can 
enter a recipe entirely from scratch, copy recipes in from other text files, create new recipes 
from one of the many templates provided with SUDS, use the SUDS recipe forumulator or 
import recipes from "SXF" files created by other SUDS users.

Entering Recipes from scratch
Copying text files into a recipe window
Entering recipe from a SUDS template
Importing recipes from "SXF files"
Using Recipe Formulator
Saving the Recipe to SUDS database



Entering Recipes from Scratch
Selecting the New recipe option from the File menu will open up a clean window in which you
may enter recipe text.    This is the easiest and most laborious method of adding recipes to 
your database.    The SUDS editor is a bare-bones editor offering most of the functionality 
found in the Notepad editor including cut/paste, etc.

You can easily cut text from another SUDS window or another windows application and paste
it into your recipe window using Window's clipboard functions (see Windows documentation 
for information on clipboard).



Copying text files into a recipe window
Text may be copied into a recipe window in a number of ways with SUDS:

Open File method within SUDS
1.Select the Open File option from the File menu.    This will allow you to open any external 
text file into a new window.    
2.Make any edits you wish and press F2 to save the recipe into the SUDS database.

Cut and Paste Method
1.From a windows application, mark text to be copied into SUDS (usually by holding down 
left mouse button and dragging over desired text).
2.From application's Edit menu, select Copy function (This should copy selected text into 
Window's internal clipboard).
3.From SUDS, select New recipe option from File menu.
4.Select Paste option from SUDS Edit menu (Text should now be in new window).



Entering Recipes from a SUDS Template
SUDS comes equipped with several "template" recipes for most popular styles of beer.    To 
add a new recipe based on one of these templates, select the Get Template option from the 
file menu.

This will open a new window with a 'starter template' for the style of beer you selected.    
Simply edit the recipe to your liking and save under a new name.

You can also add your own templates to the SUDS database.    To do so, simply prefix the 
name of your recipe with the word "template".



Importing recipes from "SXF" files
Suds "SXF" contain recipes exported from other SUDS databases.    The starter set of recipes 
"RECIPES.SXF" is distributed in this format.    To add these recipes to your database, simply 
select the Import SXF file from the Options menu in SUDS.

If a recipe already exists in your database with the same name as a recipe in the SXF file, 
the SXF recipe will NOT overlay yours.



Using the SUDS Recipe Formulator
The recipe formulator is a tool that will custom design a recipe for you and compare it to 
standard AHA beer styles based on the ingredients you enter.

To use this feature you should first select the style of beer you wish to create from the Styles
selection box displayed at the top of the formulator window. This will display the desired 
ranges for Original Gravity, percent alcohol, IBUs and color.

You should then enter the name for your recipe, quantity it makes (in US gallons, liters or UK 
gallons), and your extraction efficiency (if you are mashing).

The next step is to select the types of malts, malt extracts and/or sugars you wish to use in 
your recipe. You should press the Pick Malts button and then highlight any malts or sugars 
that you wish to use. Once selected, you then update the quantities of each. As you do this, 
the predicted gravity and color figures will be shown. You should compare these to the 
ranges shown for the style of beer you are making.

After selecting all malts and sugars to be used, you should select hops in much the same 
way and enter the quantities and times in the boil in order to calculate IBUs. The IBU value 
should also be compared against the range for the style of beer you are making.

Once all ingredients have been entered and compared agains style guidelines, you should 
then press the Notes button to enter free form information on any additional ingredients, 
mash methods, etc.

Pressing the OK button or Save button on button bar will save the recipe in the SUDS 
database.



Saving the Recipe to SUDS database
Pressing F2 or selecting the Save option from the file menu from a recipe window will display
the Recipe Details screen where all pertinant information about the recipe is entered.

The screen includes the following fields:

Recipe Name
The name of the recipe.    All recipes must have a unique name.

Method
The method used for brewing (Extract, Full mash, Partial mash, etc.) Pressing the icon next 
to this field allows you to select an existing method rather than typing You can also add your
own methods to SUDS by keying in a new value for this field not already in the list.

Category
The category for the beer style (ie Pale Ale, Stout, etc.).    You can press the icon next to this 
field to select an existing category or type in your own to add to the list.

Starting Gravity
The typical hydrometer reading taken at the start of fermentation.    Individual batches may 
vary from this!

Finishing Gravity
The typical hydrometer reading taken at the end of fermentation. Individual batches may 
vary from this!

Quantity
The quantity of beer that the recipe makes and a field to enter the unit of measure (gallons, 
liters or imperial gallons).

Aging time
How long to age the beer in weeks.



Imperial gallons (or UK gallons) are equivalent to 1.2 US gallons. Be careful when using 
British recipes as the term 'gallon' may well mean imperial gallons in that context.



Entering Log Entries
Each batch of beer you brew should be entered into a log entry tied to the appropriate 
recipe.    You must have the recipe in SUDS prior to entering the log entry.

Entering new log entries should proceed as follows:
1. Enter the recipe into SUDS if you haven't already done so.
2. Either select the Open Log option from the File Menu, or press the right mouse button 
while in the Recipe window.    If any log entries exist already, a pick list is displayed, 
otherwise you are taken directly into the log screen to enter a new log entry.
3. Fill in any pertinant information such as starting and finishing gravities and (lots of!) free-
form notes about your brewing procedures.    Selecting the OK button with the mouse or 
pressing Enter will save the log entry.    Selecting cancel will close the log entry.

Pressing the Recipe button on the log entry screen will display the recipe on which the log 
entry is based.

The log entry screen contains the following fields:

Date Started
The date the batch of beer was started.    Pressing the + or - keys in this field will increase or 
decrease the date by one day.

Date Bottled
The date the beer was bottled (or kegged).    Pressing the + or - keys in this field will increase
or decrease the date by one day.

Starting Gravity
The initial hydrometer reading for this batch of the recipe.

Finishing Gravity
The final hydrometer reading for this batch of the recipe.

Hop IBUs
The Hop IBU value for this batch of the recipe.    Clicking on the right mouse button or 
selecting the Hop IBU Calculator option from the Options menu will display the Hop IBU 
Calculator which will calculate the IBU value for you.

Alcohol content
This field is a display only field that shows only if both the Starting and Finishing gravities 
have non-zero values.    If shown, this is the approximate alcohol content for your batch.

Log Notes
This is a free-form editor where all of your notes about your batch are typed.



Hop IBU Calculator
The hop calculator will calculate the IBU value for you automatically when you provide the 
hopping information about your batch of beer.    This screen allows you to enter up to six 
"hop addition" lines to determine the bitterness factor for your brew.
Each line represents one occurrence of hops being added to your wort:

Qty
The quantity of hops added to your brew at one time.

UOM
The unit of measure (oz or grams) for the quantity entered

Hop Name
The type of hops used.    Selecting the icon next to this field will allow you to select a name 
from the current list of hop types or you may key in another hops type not on the list.

Hop AA%
The percentage of Alpha acid content for the hop used.    This information should be provided
with the hops when you purchase them!

Minutes in boil
The number of minutes that the specified quantity of hops was boiled.    This affects how 
much of the bittering of the hops went into your beer.

Selecting the OK button from this screen will then calculate the IBU value and populate the 
Hop IBUs field in the log entry screen.



Judge Log Entry

The Judge Log Entry screen contains push buttons to rate most aspects of a beer tasting. 
The categories are those outlined in The Complete Joy of Homebrewing as described in its 50
point scale.

Judged by This is the name of the person who rated this tasting.
On This is the date of the tasting.    Pressing the + or - key will increase or decrease the date
by one day.
Clarity: 1-Cloudy,2-Hazy,3-Clear,4-Brilliant
Head Retention: 1-No Head,3-Most Desirable
Aroma(of malt)/Bouquet(of hops): Poor: 1-3,Good: 4-8
Balance (of hops/malt and bitter/sweet): Poor: 1-4,Good: 5-10
Aftertaste: Poor: 1-2, Good: 3-5
Bubbles (degree of carbonation in mouth): Poor: 1-2,Good: 3-5
Body (feel of beer, full-bodied or light-bodies as appropriate): Poor: 1-2,Good: 3-5
Drinkability (after tasting): Poor: 1-4,Good: 5-10

Pressing the Notes button will display a screen to enter tasting notes.    Pressing the Print 
button will print the current tasting rating.



Exchanging recipes
SUDS provides a means to exchange your recipes with both SUDS users and non-SUDS 
users.

To provide recipes to non-SUDS users, open the desired recipe(s) windows and select the 
Save to File option from the File menu.    This will allow you to enter a filename into which the
recipe will be copied.    This file is a plain ASCII file and can be uploaded, printed or given to 
any brewer.
You can also exchange a large number of recipes with non-SUDS users by using the Export to
text file option.    This will export all files in your recipe selection list into an ASCII text file.

To provide recipes to other SUDS users, select the Export to SXF file option from the Options 
menu.    This will save all of your recipes into an SXF file that other SUDS users can Import 
into their database by using the Import from SXF option.    The advantage of this format is 
that it also carries all gravity and quantity information about your recipes as well as text.

Both export options will export only recipes that meet any filter conditions you may have 
entered!

Note - SUDS file structure and SXF files are exactly the same with both the MS-DOS and MS-
Windows releases.    Therefore you can easily run either version of the program against the 
same set of files and both DOS and Windows users can freely exchange recipes.



Homebrewing Overview

The following sections offer information and advice to beginning to intermediate homebrewers.    The 
information given is based solely on my own experiences and level of expertise!    Any technical terms 
should show up underlined.    Clicking on the term will show a definition.    This is no replacement for a 
comprehensive home brewing book!    I would strongly recommend that you beg, borrow or steal a copy of
The New Complete Joy of Homebrewing by Charlie Papazian.    This is the first text I read and is 
invaluable to new and old homebrewers.

Much of the text is based on my own opinions.    One great thing about brewing is that there is no 
shortage of opinions on virtually everything!    There's nothing like first-hand experience, so jump in and 
feel free to experiment.

Beginning to brew
Cleaning
Basic Kit Brewing
Extract/Adjunct Brewing
Mashing



Beginning to Brew

If you know how to drink beer, chances are very good that you know how to make it!    With a little trial and
error, you'll soon be able to make beers better than any you've tasted.    If you enjoy variety and are tired 
of the 'one size fits all' taste of American Pilseners, you'll find unlimited possiblities in home brewing.    The
following sections should provide some guidance in getting you started.

Common questions and answers
Basic Brewing Equipment
Kit Brewing Procedures



Cleaning brewing supplies

Sometimes it seems like I spend more time cleaning bottles, carboys and pans than I do brewing!    It is 
absolutely imperative that anything coming in contact with your beer is sanitized.    Wort is an ideal 
medium for both yeast and any bacteria that may be put in contact with it, so you definitely want your 
yeast to get the upper hand.

The easiest way to sanitize most equipment is to use a simple solution of unscented household bleach 
and water.    Use roughly 1 tsp of bleach per gallon of water (I just splash a little in).    Bottles, fermenters 
and airlocks are normally sanitized by soaking in the solution for thirty minutes or more.    Bottle labels can
also be soaked off in a bleach solution.    Since most of the bottles I get are from commercial (non-twist 
off) beers, I do a lot of label scraping!

You don't usually have to worry about the brew-pot or spoons beyond simple cleaning since the wort will 
be boiling in them (which will kill off any bacteria).



Note I use sanitize rather than sterilize because it is impossible with home equipment to fully sterilize 
beer equipment.    It is also unnecessary.



Wort is the term used for malt and water before it is fermented into beer or ale.



Common questions and answers

Is hombrewing legal?
In all but one or two states, yes.    Homebrewing falls under similar limitations as winemaking.    Each adult
may make 100 gallons per year or a maximum of 200 gallons per household.    You may not sell the 
product.    In general, fermenting beverages is legal, distilling is not.

Is homebrewing economical?
Don't embark on a hobby to save money!    That said, homebrewing can be cheaper than purchasing beer
if you count only material costs.    If you drink $10 a case beer, chances are that homebrewing would be 
more expensive.    If, however, you drink micro-brewery beer or imports, you probably can brew cheaper.   
All-grain brewing is usually cheaper than extract brewing, but much more difficult.    Normal batch sizes 
are 5 gallons which is around 2 cases.    The cost for extract brewing can range from $20 - $50 depending
on ingredients.    Outside of the US, homebrewing is often economical due to high tariffs on alcohol.

Can my beer be as good as a brewery's?
Homebrew can easily meet or exceed the quality of store-bought beer.    Don't forget that with homebrew, 
you're drinking fresh beer and have full knowledge of the ingredients.    What commercial breweries do 
well is consistently produce exactly the same beer.    You'll find that with homebrew, even with the same 
exact recipe, you probably will never exactly duplicate a batch.    It may be consistently good, but the 
homebrewer does not have the environmental control to 'clone' a batch.    That's what makes it interesting!

Is homebrew safe?
Homebrew is completely safe.    Unless someone is allergic to a specific ingredient you use, there is no 
danger in drinking homebrew.    The worst case scenario for homebrew is off-tastes.    Homebrew cannot 
create 'wood alcohol' and cannot cause blindness, etc.    Remember that homebrew is fermented, not 
distilled.    Homebrew isn't moonshine!

Where do I go for help?
If possible, join a local homebrewer's club.    There's nothing like first-hand experiences to assist you.    
Other sources are the Compuserve WINE forum (GO WINE), similar forums on other online services and 
of course, the homebrew shop that sold you your equipment!



Basic Brewing Equipment

My initial investment for my first batch of homebrew was about $80 plus ingredients.    If you already have 
a good brewpot, yours can be much less.    The easiest way to obtain equipment is to purchase a basic 
brewing equipment kit from any reputable homebrew supplier.    To brew your first batch you will need the 
following:

Brewing Kettle 
Long handle spoon 
Primary Fermenter 
Airlock/Stopper 
Siphon tubing 
Bottle capper 
Bottle caps 
Bottles 

In addition to these, I would strongly recommend the following:

Floating Thermometer 
Racking tube 
Hydrometer and test jar 
Bottling Bucket 

If you boil all five gallons of water, you will also need a good means of rapidly cooling the wortwort.    One 
good method is to purchase or make a wort chillerwort_chiller.    Sanitizing immersion wort chillers is 
usually accomplished by dropping it into the boiling wortwort shortly before the end of the boil.

If you do less than full volume boils, you can chill the wort by putting the pan into a sink full of cold water.



The brewing kettle should be at least 3 gallons in capacity and should be made of enameled steel or 
stainless steel (Aluminum may react to the acidity of the wort, but will do in a pinch). If you are doing all-
grain brewing, the kettle will need to be at least 7 1/2 gallons.



Any long kitchen spoon will do. Plastic or steel spoons are better than wood in that they can be sanitized.  
Don't worry when stirring boiling wort as the temperature will kill any bacteria on any kind of spoon.    
When stirring priming sugar, sanitation is important.



This is often a plastic, food-grade bucket with a drilled lid for an airlock.    Initially, plastic is probably your 
safest and best bet.    You may want to go to a glass carboy at some point, but have to be more careful 
about the airlock clogging as a glass carboy can explode when this happens!



This is either a one-piece or three-piece airlock with rubber stopper.    When filled with water (or Vodka to 
prevent bacteria), this keeps the air out and allows carbon dioxide to escape from the fermenter.



This is usually 3/8 inches in diameter and is used to siphon beer from fermenter into bottling bucket 
and/or from bottling bucket into bottles.



Bottle cappers fit over bottle caps and crimp them down over beer bottles forming a seal.    They usually 
come as 2-lever hand cappers or bench cappers.    Either will suffice.



Bottle caps can be obtained from the same source as your brewing ingredients.    In general, they are sold
in grosses (144).    Make sure you have enough on hand when you are ready to bottle!



You'll need roughly 52 bottles on hand for each batch.    Be sure bottles are not 'twist-off' type.    A good 
source of bottles is longneck returnables from a beer supplier.    Just don't return them!



The thermometer is used extensively in grain brewing to monitor mash temperatures.    In extract brewing 
it is often useful to steep specialty grains in the water up to 170 F.    You'll also use the thermometer when 
cooling the wort down to yeast pitching temperature (75 F).



A racking tube is a rigid plastic tube that fits on the wet side of a siphon hose.    It serves to keep the end 
of the siphon above the trub (gunk!) that accumulates at the bottom of the fermenter.    You'll use it when 
siphoning out of fermenter into secondary fermenter or bottling bucket.



The hydrometer is used to measure wort density.    Taking the density readings before and after 
fermentation allow calculation of alcohol strength.    Hydrometer readings are also essential to determine 
when fermentation has completed.    Water registers 1.000 on a hydrometer.    As an example, a batch of 
wort may measure 1.042 before fermentation and 1.010 after.    Hydrometer readings are important for 
your brewing log and are heavily used by SUDS/SUDSW.    The test jar is used to hold a wort sample 
while the hydrometer is 'floated' in it to determine reading.    A turkey baster or similar tool (sanitize it!) can 
be used to take a sample from your fermenter.



The bottling bucket is usually a food grade bucket similar to the primary fermenter, but with a spigot in the 
bottom to fill bottles from.    Its usually a good idea to put a 12 inch length of siphon hose onto the spigot 
to fill beer bottles from the bottom up.    You want to avoid aerating the beer when putting into bottles to 
prevent off flavors.



There are usually two types of wort chillers to be found.    They are immersion chillers and counterflow 
chillers.    Immersion chillers are usually cheaper and consist of 30 ft. of copper tubing wound into a coil 
with male and female hose clamps on each end.    The chiller is put into the wort and cold water is run 
through it.    The counter-flow type is a copper coil that is surrounded by cool water through which the hot 
wort is siphoned.    I have always made use of an immersion chiller with good results.



Priming is done just before bottling.    This is the process of adding a small amount of corn sugar or dry 
malt extract to the wort to promote carbonation within the bottles after capped.



Kit Brewing Procedures

For your initial batches of beer, I would recommend starting with a pre-packaged ingredients kit which 
should contain all you need in pre-measured amounts for a batch of beer along with clear directions on 
brewing it.    You should probably use a kit that is an 'all-malt' recipe rather than kits that advise adding 
several pounds of corn sugar to one can of extract.    Corn sugar is used in some beers, but generally is 
avoided as it tends to produce a thinner 'cidery' beer than an all-malt recipe.

There are many good homebrew sources for kits and some very good beer can be produced with them.    
Most kits will contain malt extract, hops, yeast, and some corn sugar for priming.    You'll also need bottle 
caps (if not provided) and of course bottles.    Make sure that you have all of the necessary supplies on-
hand as well.

You will probably start by heating some water (at least 3 gallons) to a boil.    If the kit includes specialty 
malts, it will most likely suggest steeping them in the heating water until the water nears boiling.    I usually
use a cheesecloth bag to hold the grains and remove it at 170 degrees F.

While the water is heating, you should put any liquid malt bags or cans (unopened) in some warm water 
to make the thick liquid pour easier.    Once the water is boiling, you will carefully mix in the malt extract 
and will add the boiling hops.

Towards the end of the boil, you will add aromatic hops and may add a clarifying agent such as Irish 
moss.

While the wort is boiling, you should watch carefully for boil-overs.    The thick sugary syrup has a 
tendency (especially in small volume boils) to foam up.    If this happens, reduce heat (remove pot if using 
electric burner), stir and then put back on heat.

After the boil, the wort must be cooled down to about 70 F.    The wort should be poured into the primary 
fermenter along with enough water to bring the total volume up to 5 gallons.    At this point, a hydrometer 
reading should be taken to assess the original gravity of the wort.    The yeast is then added to the 
fermenter, the top is put on with airlock and fermentation should begin within 24 hours.

If you are doing a single-stage fermentation you simply watch and wait for the airlock bubbling to cease 
and the hydrometer readings to stabilize.    If you are doing a two-stage fermentation, you should wait for 
the violent fermentation to slow and then rack the wort into the secondary fermenter.    Unless the wort will
be sitting for over three weeks there is no real advantage to two-stage fermentation over single-stage 
fermentation.

Once fermentation has completed, you are ready to bottle.    You will need to add roughly 1/2 to 3/4 cup of
corn sugar to one pint of wort or water.    To do so, boil liquid, add sugar and continue boil for a minute or 
so.    Cool liquid down.    Gradually siphon beer from fermenter into the bottling bucket.    Pour in corn 
sugar solution and gently stir in.    You may now either use spigot to fill bottles or siphon from bucket into 
bottles and cap.

Wait a few weeks and enjoy!



Malt extract is wort that has been condensed (like orange juice) into a thick syrup or dried into a sticky, 
sweet powder.    In extract and kit brewing, malt extracts are usually used and come in countless varieties.
Many are 'pre-hopped', meaning that no hops need to be used with the syrup.



Hops are flowers used in beer to give it some bitterness and aroma.    Hops also help in preserving beer.   
Hops come in many forms.    Kits will often contain hop pellets which are pulverized hops resembling 
rabbit food.    Hops also come in whole dried form or as compressed hop plugs.    Pellets keep the longest,
fresh hops are great in season.    Plugs also keep fairly well.    Good beer can be made with any of these 
forms, so feel free to experiment.



Brewing yeast generally comes as a dry yeast packet, a foil-sealed liquid package or a liquid vial.    Dry 
yeast is the easiest to work with as it doesn't require a starter solution.    Liquid yeast is generally purer 
with more varieties available, but has the disadvantage of requiring a starter.    Foil yeast packs are 'self-
starting', but if you pitch them directly into the wort, it can often take days to start fermenting unless you 
make a liquid starter solution (see Intermediate brewing procedures).    I've made good beers with both 
types of yeast.



Specialty malts are types of grain that are steeped in water to add flavor and/or coloring to your beer.    
Examples include crystal malts, roasted barley, chocolate malt, black patent malt, etc.    There's alot 
written about these in most brewing texts and free information is available from the American 
Homebrewer's Association (AHA) and most homebrew shops.



Boiling hops are hops boiled in the wort for more than 30 minutes.    In this time, the hops will lose most of
their aroma, but will contribute some bitterness to offset the sweetness of the malt extracts.    One of the 
goals in brewing is to achieve a good balance between the sweetness and bitterness.



Aromatic hops are boiled for a short time or not at all and add more aroma to the wort than flavor.



Irish moss is a dried type of seaweed that helps clarify your wort by helping heavy protiens settle to the 
bottom of the boiling kettle.



The original gravity is the 'thickness' of the wort relative to water taken before fermentation.    The 
difference between original gravity and terminal gravity is used to calculate alcohol content of the beer.



Fermentation

Fermentation should begin within 24 hours, or so, from time of pitching yeast.    This can really be 
something to watch, especially in glass carboy which provides better view.    The wort churns and bubbles 
as carbon dioxide is given off by the process.    The airlock will be visibly bubbling and a thick ring of 
bubbles will develop in the fermenting wort.

Fermentation can be as quick as 12 hours or as long as several weeks depending on amount of 
fermentables (sugars), type of yeast used and fermenting temperature.    The ideal temperature for ales is 
between 55 and 70 degrees F, lagers 38- 50 F.    For that reason, ales are generally easier to homebrew.   
True lagers will require refrigeration during fermentation.

Its important that you wait until fermentation is complete before bottling.    To tell whether fermentation is 
complete, first wait for all bubbling to cease in the airlock.    Then take a hydrometer reading.    If the 
reading stays the same for successive days, fermentation is complete and the beer is ready to bottle.



Single-Stage Fermentation

In a single-stage fermentation, only one fermenter is used for the fermentation.    Once the fermentation 
has been completed, the beer is siphoned from the fermenter into the bottling bucket.    This type of 
fermentation is appropriate as long as the wort doesn't sit in the fermenter for more than three weeks.    If 
that is not the case, you should consider Two-stage fermentation.



Two-Stage Fermentation

In a two-stage fermentation, the wort starts out in the primary fermenter as in a single-stage fermentation. 
After the initial violent fermentation has subsided (usually after 4 or 5 days), the wort is racked into the 
secondary fermenter.

Two-stage fermentation is needed when producing lager beers that must go through an extended 
fermentation at refrigerated temperatures.    Two-stage is also appropriate if you procrastinate bottling 
after fermentation for several weeks!    Otherwise, in my opinion, there's no compelling reason to do a 
two-stage fermentation.    Some argue that this leads to 'clearer' beer.



Racking is a term used meaning siphoning off of wort from one fermenter into another.    The point of 
racking is to remove the wort from the trub (gunk!) in the primary fermenter.    Extended contact with the 
trub (more than 3 weeks) can lead to off tastes in the beer.



Secondary fermenters are used to hold the fermenting wort for extended periods of time.    Often these 
are glass carboys with airlocks attached.    Glass carboys can be obtained from homebrew stores or water
companies.    Plastic may also be used for a secondary fermenter.



Extract/Adjunct Brewing

The procedures for extract/adjunct brewing are similar to those of kit brewing.    The main difference is 
that you will be purchasing the ingredients yourself and will need to make sure the right types of malt 
extracts and hops are used in the right amounts.

If you are substituting a different type of malt extract for that called for in your recipe be careful if you are 
using dry extract in place of a syrup.    When doing so, use roughly 20% less dry extract to achieve the 
same gravity as syrup.

With hops, you are likely to have more work.    Hopefully the recipe you use will give you AA percentages 
for the hops used.    Hop AA% values can vary considerably even with the same type of hop, so you will 
have to adjust quantities in order to achieve the desired bitterness levels.    Some recipes may express 
their bitterness levels in Homebrew Bittering units or International Bittering Units.    My SUDS/SUDSW 
software calculates bitterness in International Bittering Units.

In your batch, you want to hit close to the target bitterness levels.    For example, if the recipe calls for 2 
ounces of Fuggles hops with an AA level of 4.5% and the Fuggles hops you have are 2.9% AA, you will 
need to use more than the called-for amount.

If you're manually adjusting a recipe, I'd recommend using HBUs for your calculations as the math isn't as
involved.    If you're using SUDS/SUDSW, use either the SUDS IBU calculator (which requires you to 
create a log entry), or the command line IBU calculator provided to registered SUDS users.



AA percentages are the percentage of Alpha-Acid contained in the hops.    These are generally provided 
by the seller of the hops.    If you do not know the AA% values, find a new supplier of hops!    These are 
important numbers for calculating bitterness.



Homebrew Bittering Units (HBU) are an easy way to estimate bitterness.    One HBU is the ounces used 
in a 5 gallon batch of beer times the alpha acid.    For example, 2 ounces of Cascade hops at 4.2% AA 
would equal 8.2 HBUs.    This method is less exact than International Bittering Units (IBU) which take into 
account length of boil.



International Bittering Units (IBU) are a more precise way to estimate bitterness.    The calculations for 
IBUs are quite complex.    If you are interested, Home Beermaking, by William Moore gives a reasonably 
good description of this.    SUDS/SUDSW uses IBUs in measuring bitterness.    You simply provide, hop 
AA% value and boil time.



Mashing

If you are new to brewing, I would suggest sticking with extract or kit brewing for your first few batches to 
familiarize yourself with the basic procedures prior to tackling all-grain brewing.

Mashing is the process of converting the starches present in grain to fermentable sugars.    This is done 
by steeping the grain in water at a controlled temperature for an extended period of time.

Mashing can be used to produce all-grain beers or simply to enhance the flavors of extract recipes.    
There are many methods of mashing and many means to accomplish them.    I have done my own 
mashing using the simple infusion mash method in an insulated cooler.    I'll leave step-mashing and 
decoction mashing to more advanced texts and stick to infusion mashing here.

Almost all grain today is sold in a highly-modified form which makes the protein rests of other mashing 
methods unnecessary in most cases.    Try to get familiar with the basic infusion method of mashing 
before going on to other methods, if possible.

To do any form of mashing will require some additional equipment:

Grain Mill
Mash Tun
Lauter Tun
Wort Chiller

The first step in grain brewing is to grind the amount of grain that you will be using.    Try to grind the grain 
coursely so that the husks are seperated from the kernels.

Next you will need to heat one quart of water for every pound of grain to be mashed.    If you are mashing 
on a stovetop, you'll add the ground grain to the water in a big (7 1/2 gallons or more) brew pot.    
Controlling temperatures on a stovetop is difficult with a gas range and impossible on an electric.    The 
mash method I use is a ten gallon insulated picnic cooler.    The water should be heated to about 170 F 
and added to the grain in the picnic cooler.

An infusion mash should take roughly one hour to convert the starch to sugar.    After an hour, take a drop 
of the mash and put it on a clean plate.    Add one drop of tincture of iodine.    If the iodine changes color, 
the conversion is not complete.    Wait another half hour and repeat.    If no change of color occurs, the 
conversion is complete and you are ready to sparge.

Some methods recommend raising the temperature of the mash to 170 F (a mash out) to stop 
conversion.    Using a picnic cooler makes this impractical, but stove top mashing will allow this.

While conversion is taking place, you should heat roughly the same volume of water as the recipe 
quantity (5 gallons usually) to 170 F.    This will be your sparging water.    If you are using a seperate lauter
tun, gently transfer the mash into the tun.    You should first add sparge water to the lauter tun above the 
false bottom.    This will help prevent a stuck runoff.    Once all of the mash is in the lauter tun, continue to 
add sparge water until the level is about one inch above the mash.    Slowly let the water begin to drain 
from the grains while sprinkline sparge water into lauter tun to maintain one inch level above grains.    A 
rule of thumb is to let the wort drain at a rate of one gallon per ten minutes.

Once sparging is complete, the brew pot is returned to the burner for boiling and you brew just as in 
extract brewing.



Methods of Mashing

The three most common methods of mashing are:

Infusion Method The entire grain bill is combined with water and kept at a temperature of 150-158 
degrees for an hour or more until starch conversion is complete.
StepMashing This method involves taking the mash to around 122 F and holding for 30 
minutes.    This is called the protein rest.    The mash is then taken to 150 F and held for 10 minutes, 
followed by a boost to 158 F until conversion is complete.
Decoction Mashing Decoction mashing is a variation on step mashing where portions of the mash 
are brought to a boil and added back to achieve desired temperatures.



Grain Mills

It is possible to purchase the grains you use in mashing pre-crushed from most suppliers.    This is fine if 
you intend to use the grains shortly after you receive them.    However, if you will be storing grains, you 
probably should order them whole as they will keep better.    You will need some kind of grain mill to grind 
the grains prior to mashing.

Currently, there are several brands of grain mills available to homebrewers.    There are two basic types of
mill:

Grinding Mills - These grind the grain into pieces.    If using a flour mill, set it very course.    The object is 
to seperate the husk from the grain.    The Corona mill is one of the most common grain mills used for 
home brewing.

Crushing Mills - Until recently, these have been unavailable to home brewers.    Within the last year or 
two, several types are available from homebrew shops.    These are generally thought to be better than 
grinding mills since they crush the grain leaving it somewhat more intact than a grinding mill.    They are 
somewhat more expensive than grinding mills.

Personally, I use a grinding mill and have had good results.



Mash Tuns

The mash tun is the vessel used to contain the mash (ground grain and water) while the starch 
conversion takes place.    You could use your brew pot as a mash tun, an insulated picnic cooler, or a 
specially designed vessel.

Personally, I use a plain 40 quart Coleman picnic cooler.    Picnic coolers work great since once the mash 
is at temperature, they can easily hold it for 90 minutes or more while starch conversion takes place.

Whatever you use, make sure it is big enough to hold ten or more pounds of grain along with the mashing
water.



Lauter Tuns

The lauter tun is used for sparging the grains.    It normally consists of some form of 'false bottom' that 
serves to strain the sweet wort from the grains after mashing.    Lauter tuns can be integrated into the 
mash tun, seperate devices or specially designed mesh bags used within the mash tun.

There are many devices available to the home brewer for lautering.    Get first-hand advice from other 
brewers before making an investment.

There are also good directions in The New Complete Joy of Homebrewing for making your own lauter tun 
from two food grade buckets and some siphon hose.    This is the method that I use.



Sparging is the process of rinsing the mashed grains with hot (170 F) water to seperate the sugars from 
the grains.    The resulting wort goes into the brew pot for boiling.



A stuck runoff occurs whenever the mash gets firmly packed into the false bottom thus preventing the 
wort from draining during the sparge.    This can be prevented by alternating the addition of mash and 
sparge water thus 'floating' the grains into the lautering tun.




